
            
1

Tyros4 Voice Editor
Owner’s Manual

Tyros4 Voice Editor

Contents
About the Voice Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .2
Before Using the Voice Editor . . . . . . . . . . . . . . . . . . . . . . . . . .3

Preset Voice Receiving. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4

Voice Editor Procedure  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .5
About Voice Editor Windows . . . . . . . . . . . . . . . . . . . . . . . . . . .6

The Menu Bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

The Library Window . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

The Edit Window  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12

Troubleshooting . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .22

• The software and this owner’s manual are exclusive copyrights of Yamaha Corporation.
• Copying of the software or reproduction of this manual in whole or in part by any means is expressly forbidden 

without the written consent of the manufacturer.
• Yamaha makes no representations or warranties with regard to the use of the software and documentation and 

cannot be held responsible for the results of the use of this manual and the software.
• The company names and product names in this Owner’s Manual are the trademarks or registered trademarks of 

their respective companies.
• The screen displays as illustrated in this Owner’s Manual are for instructional purposes, and may appear 

somewhat different from the screens which appear on your computer.
• Copying of the commercially available musical data including but not limited to MIDI data and/or audio data is 

strictly prohibited except for your personal use. 
• The following instruments, shown in the displays of the computer, are on display at the Hamamatsu Museum of 

Musical Instruments: balafon, gender, kalimba, kanoon, santur, gamelan gong, harp, hand bell, bagpipe, banjo, 
carillon, mandolin, oud, pan flute, pungi, rabab, shanai, sitar, steel drum, tambra.

• The photos of the harpsichord, bandoneon, hackbrett, music box, dulcimer and cimbalom, shown in the displays 
of the computer, are courtesy of the Gakkigaku Shiryokan (Collection for Organolgy), Kunitachi College of Music.

© 2010 Yamaha Corporation. All rights reserved.

This owner’s manual assumes that you are already familiar with basic Windows operations. If you are not, 
please refer to the owner’s manual which came with your Windows software before using Voice Editor.

For information about hardware requirements, the interconnection of devices and the installation of the Voice 
Editor software, refer to the separate “Installation Guide” as well as the Owner’s Manual for the respective MIDI 
device.
Tyros4 Voice Editor



     
2

About the Voice Editor
The Tyros4 Voice Editor is a software application that makes it easy to access and edit the Tyros4 
voice and effect parameters via a comprehensive visual interface. The data is transferred between 
the computer and instrument in real time—enabling you to play the voice on the Tyros4 as soon as 
you’ve edited it. Once you’ve finished editing the voice on the computer, you can directly store it to 
an Expansion Voice Bank on the Tyros4.

When using the Voice Editor, make sure the computer and Tyros4 are connected.

Computer (Windows)

USB 
cable

Voice Editor

Tyros4

3. Store the edited voice to an 
Expansion Voice Bank on the Tyros4. 
(This enables you to use the voice in 
the same way as a preset voice.)

1. Transfer Preset Voices to 
the computer (page 4)

Preset Voices

Expansion Voice Bank

2. Edit a voice on the 
computer
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Before Using the Voice Editor
The following operations—MIDI port settings and Preset Voice Receiving—must be done when 
you launch the Voice Editor for the first time.

1. Install the USB driver on your computer.
For instructions on how to install, refer to the Installation Guide that comes with the Tyros4.

2. Connect the computer and instrument with a USB cable, then turn the power of the 
instrument on.

3. Launch the Voice Editor.
From the “START” menu, select “Programs” → “YAMAHA Tyros4 Voice Editor” → “Tyros4 
Voice Editor”.

4. Click the MIDI SETUP button in the Toolbar called up via step 3.
The MIDI window appears. Select the appropriate device from the [IN]/[OUT] box, in order 
to use the Tyros4 connected to the USB terminal. (For example, select “Digital Workstation-
1.”) 

5. Click “OK.”
The Preset Voice Receive dialog appears.

6. In the Preset Voice Receive dialog, first set up the MIDI port then start reception of the 
preset voices from the Tyros4.
For details on the Preset Voice Receive dialog, refer to page 4.

The port settings and reception of preset voices have been completed. These operations 
are not necessary the next time you launch the Voice Editor. 
Tyros4 Voice Editor
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The first time the Voice Editor is launched after installation the Preset Voice Receive dialog window 
shown below will appear. The preset voice data must be loaded from Tyros4 before you can edit 
custom voices.

1. Click “Setup” and set the ports as required in the dialog window that appears.

2. Click “Start” to begin loading the preset voice data.

3. A dialog window will appear to inform you when the load operation has finished. Click “OK” 
to continue.

The Preset Voice Receive dialog will not appear when the application is launched again after the 
preset voices have been loaded the first time. If you press “Stop” during the load process the data 
received up until that point will be considered invalid and the Preset Voice Receive dialog will 
appear the next time the application is launched. Similarly, if you click “Close” before loading the 
preset voice data, the Preset Voice Receive dialog will appear the next time the application is 
launched.

If you want to reload the preset voice data, delete the program’s “Preset.ini” file and then re-launch 
the Voice Editor. The default location for the “Preset.ini” file is:
[Windows XP] C:\Documents and Settings\(login name)\ Local Settings\Application Data\YAMAHA\

Tyros4 Voice Editor\Module\MVEditor\Tyros4\
[Windows Vista/7] c:\Users\(login name)\AppData\Local\YAMAHA\Tyros4 Voice Editor\Module\

MVEditor\Tyros4\
If you cannot find this folder, select “Folder Options” from the Tools menu of the Explorer, then check 
“Show hidden files and folders” in the View tab.

Preset Voice Receiving

NOTE
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Voice Editor Procedure
1. Connect the computer and instrument with a USB cable, then turn the power of the 

instrument on.

2. On the instrument, select the voice you want to edit.

3. Launch the Voice Editor on the computer.
From the “START” menu, select “Programs” → “YAMAHA Tyros4 Voice Editor” → “Tyros4 
Voice Editor”.
The Library window and Edit window of the Voice Editor appear on the computer display, 
and the CUSTOM VOICE EDIT display appears in the Tyros4 LCD.

If the CUSTOM VOICE EDIT display is not called up automatically, press the [VOICE CREATOR] 
button followed by the [F] (CUSTOM VOICE EDIT via PC) button on the instrument to call up the 
display.

4. Edit the voice you have selected in step 2 from the Edit window (page 12).

5. When you finish editing, select “Store” from the Edit menu to store the voice.
The dialog appears prompting you to store the data directly on the instrument. 
Store the voice as a file to an Expansion Voice Bank on the instrument. For details on 
storing, refer to the Reference Manual of the Tyros4.

6. After the Store operations (on the instrument) are finished, close the dialog on the 
computer.

7. If you want to continue editing with another voice, double-click the desired voice in the 
Library window. 
The Edit window for the selected voice will open. By repeating steps 4 through 6, you can 
edit as many voices as you need.

8. Exit the Voice Editor.
Select “Exit” from the File menu, or click the X mark in the right corner of the Library window.

Computer Tyros4

NOTE
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About Voice Editor Windows

A number of editing and setup functions are available via the menu bar. Click on the menu titles to 
see the corresponding pull-down menu. Select the desired function or command from the pull-
down menu. Selections that are not available will appear in gray.

Frequently used items from each menu will appear as icon buttons in the toolbar.

File
Exit
Quits the Voice Editor application.

Edit
Edit
Performs the same function as the toolbar Edit button (page 
11).

Library
Performs the same function as the toolbar Library button (page 
21).

Store...
Performs the same function as the toolbar Store button (page 
21).

Compare
Performs the same function as the toolbar Compare button 
(page 21).

Setup
Setup...
Performs the same function as the toolbar Editor Setup button 
(page 10).

Monitor
Performs the same function as the toolbar Monitor button 
(page 11).

All Sound Off
Clears all sounds currently sounding.

The Menu Bar

NOTE
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Window
Lists the currently open windows. When you select a window 
from the list, that window will become active.

Help
Manual
Starts the online manual. 

About
Displays version and other information about the Voice Editor.
Tyros4 Voice Editor
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When the Voice Editor is launched, a Library Window like the one shown below will appear. The 
Library Window displays a list of the available voices. The type of voices displayed can be switched 
by clicking the appropriate voice type tab e. Any of the listed voices can be selected for editing, 
opening it in the Voice Edit Window, by either double-clicking the voice name, or single-clicking the 
voice name and then clicking the toolbar Edit button.

q Toolbar
Most important functions and commands can be executed via these buttons (page 10).

w ON-LINE Indicator
This will turn blue when the Voice Editor communicates with the Tyros4. If the Voice Editor is 
disconnected from the instrument, this indicator will turn gray.

e Voice Type Tabs
Select the type of voices displayed in the voice list.
The Custom Normal and Custom Drum tabs contain custom voices and custom drum voices 
you have created. The remaining preset voice tabs provide access to the preset voices loaded 
from Tyros4, and these are used as the basis for new custom voices that you will create.

r Voice List
Each voice—voice name and number—is displayed on a single line. Use the scroll bar to scroll 
through the list and access all available voices as required.

The following Voices cannot be edited using the Voice Editor.
• Premium Voices
• Organ Flutes Voices
• GS Voices
• Mega Voices
• SA/SA2 Voices

The Library Window

r

q

e

wCustom Voices Preset Voices
These arrows scroll through

the voice type tabs.

NOTE
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Changing Column Width

Move the cursor over the dividing line between the column names at the top of the voice list 
and it will change to the split tool. Drag the dividers to resize the columns as required.

If you simply double-click with the split tool the column will automatically resize to minimum 
width.

Display Voice Names Only

Right click over the voice list and select “List” to switch to an overview of all the voice names in 
the current bank. This display mode can make it easier to locate a specific voice.

Right click over the Voice Names list and select “Details” to return to the voice name and number 
display.

NOTE

NOTE
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Toolbar

q Editor Setup Button
Opens the Setup dialog window.

Setup Dialog

The settings in this dialog enable the Voice Editor to communicate with the Tyros4 hardware. 
Use the mouse and keyboard to make the necessary settings, the click “OK” to close the 
dialog window and enable the settings. Use the “Cancel” button to close the dialog without 
making any changes to the current settings.

q MIDI In Port ........................ Click the box and select an input port from the drop-down list. 
The Voice Editor will receive data from Tyros4 via the selected 
port. Be sure to select the port to which Tyros4 is connected.

w MIDI Out Port ..................... Click the box and select an output port from the drop-down list. 
The Voice Editor will transmit data and commands to Tyros4 
via the selected port. Be sure to select the port to which 
Tyros4 is connected.

e MIDI Ch (MIDI Channel) .... Selects the MIDI channel via which note-on data will be 
transmitted when a key on the keyboard in the Edit Window is 
clicked.

Please set this parameter to “1”.

r Device No. ......................... Sets the device number to be used for transmission and 
reception of system exclusive data (used for bulk data 
transfers). Set to the same device number as Tyros4.

Please set this parameter to “1”.

q w e

q

w

e

r

NOTE

NOTE
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w Edit Button
Opens the currently selected voice in the Edit Window (Common).

e Monitor Button
Enables you to monitor the currently edited voice when you play the keyboard on the Tyros4.

The appropriate MIDI port and other system settings must be made in order for the Monitor 
function to work properly. Refer to page 10 for details.

NOTE
Tyros4 Voice Editor
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This window provides a comprehensive, intuitive interface for editing Tyros4 parameters. The 
Tyros4 voice and effect parameters are presented in a graphical interface that makes editing and 
control easier than ever. Two types of Edit Window are provided: a Normal Voice Edit Window 
(page 12) for normal pitched voices, and a Drum Voice Edit Window (page 19) for drum voices in 
which various drum and percussion sounds are assigned to different keys.

• Edit Window settings are transferred to the Tyros4 in real time via MIDI.
• For detailed information on the various parameters please refer to the Tyros4 Reference Manual 

and data lists.

Normal Voice Edit Window (Common)

q Toolbar
The toolbar includes buttons which access and execute a number of important functions (page 
21).

w Voice Name
The name and icon of the voice being edited are displayed here. Click on the voice name to 
enter a new name via the computer keyboard, or click the icon to select a different icon for the 
voice.

Voice names must be 16 characters or less. A space or period cannot be used as the first 
character of a voice name, and the following characters cannot be used anywhere in a voice 
name:  “  *  :  <  >  \  |  /  ?
You cannot give the same name to two different voices.

The Edit Window

q

t

w

r

y

e

NOTE

NOTE
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e Voice Set Parameters
These are the same parameters as those accessible via the Tyros4 Voice Set function when a 
voice other than an Organ-flute type is selected. Please refer to the Tyros4 Reference Manual 
for details.

r Element Unit
Provides access to the element parameters (page 13). As in many other electronic musical 
instruments, Tyros4 voices can be made up of a number of “elements.” Other voice parameters 
affect all elements simultaneously, but the element parameters individually control a specified 
element.

t On-screen Keyboard
Click or drag to hear the results of an edit operation.

This keyboard has no effect on the PART OCTAVE parameter in the Voice Set parameter group 
above.

y Harmony
Includes the harmony/echo parameters—the same as those accessed via the Tyros4 
[FUNCTION] → HARMONY/ECHO display. Please refer to the Tyros4 Reference Manual for 
details. Numbers in parentheses following a parameter name—e.g. Echo (4)—indicate the 
echo, tremolo, or trill speed.

• The control mode of the on-screen knobs can be switched as required. Right-click near a knob 
and select the desired mode from the drop-down menu. This setting applies to all knobs.

• The knobs can also be operated via the computer keyboard’s Page Up and Page Down keys.

Element Unit

q EL (Element) 1–8
Opens the Element dialog window (page 14).

w ON/OFF
Turns the element on or off (mute).

e Adjusts the output level of each element.

NOTE

NOTE

q w e q w e
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● Element 1–8 Dialog

q LFO WAVE
Selects the LFO waveform. The waveform selected here is used for modulation, creating a 
range of periodic effects.

w LFO SPEED
Sets the speed (frequency) of LFO modulation. Higher values produce higher speeds.

e PHASE INIT
When this is set to ON, the LFO phase is reset with each note-on event.

r LFO PITCH (Pitch Modulation Depth)
Sets the depth of LFO pitch modulation.

t LFO FILTER (Filter Modulation Depth)
Sets the depth of LFO filter cutoff frequency modulation.

y LFO AMPLITUDE (Amplitude Modulation Depth)
Sets the depth of LFO amplitude modulation.

u MIX
Adjusts the element’s output level (LEVEL) and stereo position (PAN).

i DETAIL
Click to open the EL Detail (Element Detail) dialog window. The EL Detail dialog window allows 
direct numeric entry of element parameter values. The values edited here are linked to the 
element dialog graphs.

q

e
w

r t y u

i

Described on the 
following page.
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Edit Procedure
To edit parameters via the graphs, drag the square marker in the display (■) in the directions 
indicated by the arrows. The current value of the parameter will be displayed while the cursor is 
over the marker (■).

In some cases the markers will overlap. Detailed parameter settings can be checked in the EL Detail 
dialog window by clicking the DETAIL button.

OSCILLATOR
Selects the elements that make up a voice (category, voice number, element number), and 
provides access to the VEL LIMIT and NOTE LIMIT parameters. One of the markers sets the VEL 
LIMIT LOW and NOTE LIMIT LOW parameters. Dragging the marker to the left or right sets the 
lowest note in the element’s keyboard range, and dragging the marker up or down sets the lowest 
keyboard velocity at which the element will sound. The other marker is used to adjust the VEL 
LIMIT HIGH and NOTE LIMIT HIGH parameters. Dragging this marker to the left or right sets the 
highest note in the element’s keyboard range, and dragging the marker up or down sets the 
highest keyboard velocity at which the element will sound. The active range is displayed in green 
on the graph.

The following parameters can be set via the OSCILLATOR page of the EL Detail dialog window.

Regardless of the Note Limit or Velocity Limit parameter settings, some Elements do not sound for 
specific notes/velocities.

Category, Voice, Element Selects or deletes the elements that make up the voice.

Volume Adjusts the volume of the element.

Pan Adjusts the pan (stereo position) of the element.

Key On Delay Time Sets a delay between key-on and the instant the element begins to produce 
sound. Different delays can be set for each element.

Pitch Scaling Center Note Sets the center note for keyboard pitch scaling (keyboard: note number). The 
pitch of the specified center note will not change regardless of the pitch scaling 
sensitivity setting.

Pitch Scaling Sens. Sets the pitch scaling sensitivity of the element (the amount of pitch variation 
between adjacent notes).

Touch Curve Sets the volume response curve in relation to keyboard dynamics.

Touch Curve Sens. Adjusts the keyboard dynamics sensitivity based on the Touch Curve setting 
above.

Note Shift Adjusts the pitch of the element in semitone steps.

Tune Fine Allows fine adjustment of element pitch.

Note Limit High, Note Limit Low Set the keyboard range over which the element will sound.

Velocity Limit High, Velocity Limit Low Set the velocity range over which the element will sound.

NOTE

Element Selection
Opens the EL Detail (Element Detail) dialog window 
for detailed numeric editing and verification.

NOTE

NOTE
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FILTER 1
Sets the FILTER 1 parameters.
Drag the marker to the left or right to adjust the filter’s cutoff frequency, and therefore the 
brightness of the sound. Drag the marker upward to increase the filter’s resonance—a resonant 
peak at the cutoff frequency—to produce resonant analog synthesizer type timbres.

• These parameters can also be edited numerically via the EL Detail dialog window DCF page.

• Each Tyros4 voice has two filters. The FILTER 1 parameters can be accessed through this dialog 
window. Both the FILTER 1 and FILTER 2 parameters can be edited via the EL Detail dialog 
window.

• The following parameters can be accessed via the EL Detail dialog window’s DCF page.

LFO
Adjusts the LFO delay and fade parameters.
The left marker adjusts the delay between key-on and the beginning of the LFO effect (LFO 
Delay), while the right marker adjusts the length of the LFO fade-in time (LFO fade Time).

• These parameters can also be edited numerically via the EL Detail dialog window’s LFO page.

• The following parameters can be accessed via the EL Detail dialog window’s LFO page.

DCF1 Type Selects the DCF1 filter type.

DCF1 Cutoff Frequency Adjusts the DCF1 filter cutoff frequency.

DCF1 Resonance Adjusts the strength of the DCF1 filter resonance effect.

DCF1 Cutoff Velocity Sens. Adjusts the sensitivity of the DCF1 filter cutoff frequency to keyboard velocity.

DCF1 Resonance Velo Sens. Adjusts the sensitivity of DCF1 filter resonance to keyboard velocity.

DCF1 Cutoff Scaling BP1–4 Specifies the DCF1 cutoff frequency scaling breakpoints (note numbers).

DCF1 Cutoff Scaling Offset 1–4 Adjusts the amount of cutoff frequency offset at each of the cutoff scaling 
breakpoints.

DCF2 Type Selects the DCF2 filter type.

DCF2 Cutoff Frequency Adjusts the DCF2 filter cutoff frequency.

DCF2 Resonance Adjusts the strength of the DCF2 filter resonance effect.

DCF2 Cutoff Velocity Sens. Adjusts the sensitivity of the DCF2 filter cutoff frequency to keyboard velocity.

Wave Selects the LFO waveform.

Speed Adjusts the speed (frequency) of LFO variation.

Phase Init Determines the phase of the LFO waveform will be reset whenever a note is 
played.

PMD (Pitch Modulation Depth) Sets the depth of modulation applied when the LFO is used for pitch 
modulation.

FMD (Frequency Modulation Depth) Sets the depth of modulation applied when the LFO is used for frequency 
modulation.

AMD (Amplitude Modulation Depth) Sets the depth of modulation applied when the LFO is used for amplitude 
modulation.

Delay Time Adjusts the delay between key-on and the beginning of the LFO effect.

Fade Time Adjusts the length of the LFO fade-in time, beginning after the Delay Time 
(above) and ending when the LFO reaches full amplitude.

NOTE

NOTE
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PITCH EG (Pitch Envelope Generator)
The pitch envelope generator controls time-based variations in pitch from initial attack through final 
decay via one Time parameter, four Rate parameters, and five Level parameters.
Drag a marker left or right to adjust rate or time, and drag up and down to adjust level. The leftmost 
marker adjusts Hold Time/Initial Level, the second marker from the left adjusts Decay 1 Rate/
Level, the third marker adjusts Decay 2 Rate/Level, the fourth adjusts Decay 3 Rate/Level, and the 
rightmost marker adjusts Release Rate/Level.

• These parameters can also be edited numerically via the EL Detail dialog window’s PITCH EG 
page.

• The following parameters can be accessed via the EL Detail dialog window’s PITCH EG page.

FILTER EG (Filter Envelope Generator)
The filter envelope generator controls time-based variations in timbre from initial attack through 
release via one Time parameter, four Rate parameters, and five Level parameters.
Drag a marker left or right to adjust rate or time, and drag up and down to adjust level. The leftmost 
marker adjusts Hold Time/Initial Level, the second marker from the left adjusts Decay 1 Rate/
Level, the third marker adjusts Decay 2 Rate/Level, the fourth adjusts Decay 3 Rate/Level, and the 
rightmost marker adjusts Release Rate/Level.

• These parameters can also be edited numerically via the EL Detail dialog window’s FILTER EG 
page.

• The following parameters can be accessed via the EL Detail dialog window’s FILTER EG page.

Level Velocity Sens. Sets the sensitivity of pitch EG level in relation to keyboard velocity.

Rate Scaling Center Note Sets the center note for pitch EG rate scaling in which the overall envelope 
rate varies according to the note played.

Rate Scaling Sens. Sets the pitch EG’s sensitivity to rate scaling according to the note played.

Rate Velocity Sens. Sets the pitch EG’s sensitivity to rate scaling according to keyboard 
dynamics.

Hold Time These parameters control time-based variations in pitch from the initial attack 
of each note to the final decay.Decay 1 Rate

Decay 2 Rate

Decay 3 Rate

Release Rate

Initial Level

Decay 1 Level

Decay 2 Level

Decay 3 Level

Release Level

Rate Scaling Sens. Sets the filter EG’s sensitivity to rate scaling according to the note played.

Level Velocity Sens. Sets the sensitivity of filter EG level in relation to keyboard velocity.

Hold Rate Velocity Sens. Sets the sensitivity of filter EG hold rate in relation to keyboard velocity.

Decay 1 Rate Velocity Sens. Sets the sensitivity of filter EG decay 1 rate in relation to keyboard velocity.

Other Rate Velocity Sens. Sets the sensitivity of all filter EG parameters other than the hold and attack 
rates in relation to keyboard velocity.

Hold Time These parameters control time-based variations in filter cutoff frequency from 
the initial attack of each note to the final decay.Decay 1 Rate

Decay 2 Rate

Decay 3 Rate

Release Rate

Initial Level

Decay 1 Level

Decay 2 Level

Decay 3 Level

Release Level

NOTE

NOTE
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AMPLITUDE EG (Amplitude Envelope Generator)
The amplitude envelope generator controls the overall “shape” (amplitude envelope) of each note 
from initial attack through final decay.
Drag the leftmost marker up or down to adjust the sensitivity of attack time to velocity (Initial Level). 
Drag the second marker from the left or right to adjust EG Attack Rate, or up and down to adjust 
EG Attack Level. Drag the third and fourth markers left or right to adjust the way the sound decays 
while a note is held (EG Decay rate 1 and 2), and up or down to adjust the EG Decay Level 1 and 
2 parameters. Drag the fifth marker left or right to adjust the way the sound decays after the Decay 
2 Level is reached (EG Decay 3 Rate). When EG Decay 3 Rate is set to “0,” the sound will sustain 
as long as the note is held. Drag the rightmost marker left or right to adjust the way the sound 
decays after a note is released (EG Release Rate).

• These parameters can also be edited numerically via the EL Detail dialog window’s AMP EG page.

• The following parameters can be accessed via the EL Detail dialog window’s AMP EG page.

• The following parameters can be accessed via the EL Detail dialog window’s AEG SCALE page.

Attack Rate Velocity Sens. Sets the sensitivity of the filter EG attack rate in relation to keyboard velocity.

Attack Rate These parameters control time-based variations in amplitude from the initial 
attack of each note to the final decay.Decay 1 Rate

Decay 2 Rate

Decay 3 Rate

Release Rate

Initial Level

Attack Level

Decay 1 Level

Decay 2 Level

Rate Scaling Sens. Sets the amplitude EG’s sensitivity to rate scaling according to the note 
played.

Level Scaling Break Point 1–4 Specifies the amplitude scaling breakpoints (note numbers).

Level Scaling Offset 1–4 Adjusts the amount of amplitude offset at each of the cutoff scaling 
breakpoints.

NOTE
Tyros4 Voice Editor



19

Drum Voice Edit Window
Here you can select and edit individual keys/drum sounds.

q Toolbar
The toolbar includes buttons that access and execute a number of important functions (page 21).

w Voice Name
The name and icon of the kit being edited are displayed here. Click on the kit name to enter a 
new name via the computer keyboard, or click the icon to select a different icon for the kit.

Kit names must be 16 characters or less. A space or period cannot be used as the first character 
of a kit name, and the following characters cannot be used anywhere in a kit name:  “  *  :  <  >  \  
|  /  ?
You cannot give the same name to two different voices.

e Voice Set Parameters
These are the same parameters as those accessible via the Tyros4 Voice Set function when a 
voice other than an Organ-flute type is selected. Please refer to the Tyros4 Reference Manual 
for details.

r Element Unit
Provides access to the drum element (key) parameters. Click a key (C#-1 ... G5) to open the 
corresponding Drum Key dialog window (page 20).

t On-screen Keyboard
Click or drag to hear the results of an edit operation.

This keyboard has no effect on the PART OCTAVE parameter in the Voice Set parameter group 
above.

y Harmony
Includes the harmony/echo parameters—the same as those accessed via the Tyros4 
[FUNCTION] → HARMONY/ECHO display. Please refer to the Tyros4 Reference Manual for 
details. Numbers in parentheses following a parameter name—e.g. Echo (4)—indicate the 
echo, tremolo, or trill speed.

q

t

w

r

y

e

NOTE

NOTE

NOTE
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● Drum Key Dialog

q Drum Key
The note currently selected for editing.

w Keyboard
Click on a key to select the drum or percussion sound assigned to that key for editing.

This keyboard has no effect on the PART OCTAVE parameter in the Voice Set parameter group 
above.

e Category, Voice, Key Name
Display the category, voice, and key name of the drum or percussion sound currently selected 
for editing. You can click in any of these boxes to select a different sound.

r Receive Note On
Specifies whether MIDI note-on data will be received for each wave. When this is set to “Off,” 
the wave is muted.

t Receive Note Off
Specifies whether MIDI note-off data will be received for each wave.

y Key Assign
Sets the key assign mode. This parameter is only available when the XG parameter “SAME 
NOTE NUMBER KEY ON ASSIGN” in the Tyros4 tone generator block is set to “INST.”

u Alternate Group
This function can be used to prevent sounds that would not normally sound together in a drum 
kit from sounding at the same time (for example, hi-hat pedal and open hi-hat).

i Fine
Allows fine tuning around the basic pitch set by “o Coarse”, below.

o Coarse
Adjusts the pitch in semitone increments.

!0 Cutoff
Sets the cutoff frequency of the LPF (Low-Pass Filter).

!1 Reso
Adjusts the strength of the LPF resonance effect.

!2 Attack
Adjusts the attack (amplitude) of the sound.

q

e

t

r

y

u

w

o

i !0

!1 !2

!3 !4

!5

!6

!7

!8

!9 @0 @1

NOTE
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!3 Decay 1
Adjusts the way the sound decays (Amplitude EG Decay 1).

!4 Decay 2
Adjusts the way the sound decays (Amplitude EG Decay 2).

!5 Level
Sets the output level of each wave.

!6 Pan
Sets the pan position (stereo position) of each wave.

!7 Reverb
Sets the send level of the reverb effect.

!8 Chorus
Sets the send level of the chorus effect.

!9 Pitch
Sets and fine-tunes the pitch. This parameter is linked to i and o, above.

@0 Filter
Adjusts the brightness and character of the sound. Editing via the graph is the same as in the 
element dialogs. This parameter is linked to !0 and !1, above.

@1 Amplitude EG
Adjusts the amplitude envelope of the sound from initial attack through final decay. This 
parameter is linked to !2, !3, and !4, above.

Toolbar

q Editor Setup Button
Opens the Setup dialog window. Refer to page 10 for details on the Setup dialog window.

w Library Window Button
Opens the Library Window. Refer to page 8 for details on the Library Window.

e Store Button
Open the Store dialog, which prompts you to store the data on the instrument. (The edited data 
cannot be saved on the computer; it must be saved on the instrument.)

r Compare Button
When this function is turned on, you can monitor the currently edited voice by playing the 
keyboard of the Tyros4. When set to off, you can monitor the unedited (original) voice.

q w e r
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Troubleshooting
If you encounter problems such as no sound output or abnormal behavior, verify the connections 
before checking the following. Furthermore, if you are using the Voice Editor as a plug-in with a client 
application refer to the client application’s documentation or on-line help for further information.

Sound does not change when using 
knobs or sliders.

• Are the MIDI Out port and Device Number set 
correctly in the Editor Setup? (page 10)

Sound is doubled when playing the 
keyboard.

• Switch Local to OFF on your Tyros4, or set 
MIDI Thru to “Off” on your client application.

No sound heard when clicking on-screen 
keyboard in Edit Window.

• Is the MIDI channel set correctly in the Editor 
Setup? (page 10)

No sound when the Monitor button is 
pressed.

• Are the MIDI Out port and Device Number set 
correctly in the Editor Setup? (page 10)

Bulk data is not received.
• Open the Editor Setup Dialog and check that 

the MIDI ports and Device Number have been 
properly assigned (page 10).

• Depending on the client application, you 
might have to turn the client application’s 
MIDI Thru setting “Off”.

MIDI In/Out port is not available in Editor 
Setup.

• If you are using the Voice Editor with a client 
application you may have to set the MIDI 
ports via the client application. Check the 
client application’s MIDI In/Out settings.

Insufficient Memory message appears 
when selecting an element or drum key.

• The actual data size of each voice depends 
on the elements or keys used. Furthermore, a 
maximum size is defined for all voices and in 
some cases a voice may exceed this 
maximum size due to the element or key 
structure used. Delete some voices or 
change the element/key structure of the 
voice.

An asterisk (*) appears before LFO Phase 
Init/LFO Wave Type/Filter 1/2 type 
parameters.

• This occurs with non-continuous parameters 
which may be different for each key.

Multiple Voice Editors can be launched 
when the Voice Editor is used as a plug-in.

• Some client applications allow multiple 
instances of the same plug-in to be active. 
When editing for a single Tyros4 unit, 
however, using more than one Voice Editor 
can lead to errors. Please launch only one 
Voice Editor at a time.

Voice Editor does not work properly.
• Is the Voice Editor for Tyros/Tyros2/Tyros3 

running?
The Tyros4 Voice Editor may not work 
properly when the Voice Editor for Tyros/
Tyros2/Tyros3 is running. (These three editors 
are for different devices and cannot be used 
at the same time.)

ON-LINE indicator does not light (or ON-
LINE indicator has been turned off).

• Are the MIDI IN/OUT ports set correctly in the 
Editor Setup?

• Is the LCD of the Tyros4 set to the “CUSTOM 
VOICE EDIT via PC” display?

• Try restarting the Voice Editor and clicking the 
MIDI Setup button to select the appropriate 
MIDI port. (If the MIDI Setup button is not 
displayed, right-click the MIDI Setup icon on 
the Windows Task Tray and select “Show” to 
display it.)

• Performing operations on the instrument 
while a dialog box, prompt or other special 
message is open on your computer may 
cause the editor to go offline. Before 
performing any operations on the instrument, 
make sure to close all open dialogs on the 
connected computer.
Tyros4 Voice Editor
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